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Introduction to

MasterClips MediaPaq Browser

Introduction
Welcome to MasterClips MediaPaq Browser, the easy, efficient method for organizing, cataloging, and

using your multimedia and graphic files. The clip art images included in this package were handpicked in
order to satisfy your varied destktop publishing needs. Now you can add new convenience to managing and
using your art files in any of your Windows applications.

However, it doesn’t end with just clip art! You will also find two extra features in this package. The
MasterClips Fonts Utility brings you 2000 TrueType Fonts, and the MasterClips Sound Manager rings in with
150 WAV files.

Before you begin, let us first look at some of the many features included in the MasterClips MediaPaq
Browser system. This user guide will cover some technical aspects and introduce you to the file naming and
organizational conventions which enable you to locate and extract clipart images.

File Names and Organization
MasterClips MediaPaq Browser contains Windows Metafiles (WMF graphic files) and fills over 100 dif-

ferent categories. MasterClips MedaiPaq Browser conforms to the standard 8-character file name. Often times,
searching for a specific graphic can be puzzling since an image like “tractor,” for instance, could theoretically
fall into many categories: transportation, agriculture, transportation, etc. Luckily, one of MasterClips MediaPaq’s
most convenient features, the keyword seach, makes finding specific images simple. After you learn the strat-
egies for navigating around the system, the powerful search engine will have you flying through libraries or
the whole collection, for that matter.

Media Management Features
ω Organize all types of files into thumbnail indexed libraries.

ω Each thumbnail representation includes mini-icons which indicate whether the object has attached notes,
sound, or contains multiple pages.  Compression method and relative disk storage percentage (i.e., amount
of disk space compared to the original file) required are also displayed with each image.

ω Thumbnail view window provides a view and access to many images at one time (the number of images
displayed in the thumbnail view window varies with the screen resolution you are using in Windows).
View, manipulate, and convert images from one simple view window.

ω MasterClips MediaPaq Browser offers drag-and-drop image placement for those Windows applications



Introduction to MasterClips MediaPaq Browser

MasterClips MediaPaq Browser1-2

that support Object Linked Embedding (OLE) data transfer.  Simply click on the desired image in the
MasterClips MediaPaq Browser, and drag it to another application to use it.

ω Complete printer support permits you to print one image file at a time, or print entire libraries in full-page,
half-page, or thumbnail catalog format.

ω MasterClips MediaPaq Browser includes support for a number of different image formats as well as video
(“AVI”) files and sound (“WAV”) files.

ω MasterClips MediaPaq Browser features a unique SpeedBar that allows quick access to media libraries.

ω You can resize the thumbnail view of the images from 64 x 48 pixels to 256 x 256 pixels.

Image Manipulation Features
ω Bitmapped image operations include Copy, Paste, Crop, Rotate, Resize, Zoom, Flip, Invert, Contrast,

Brightness, Gamma Correction, and Inversion.  Bitmapped image process techniques are available, such
as edge detection, dilation, sharpening, smoothing, image conversions for 1-bit to 4-bit to 8-bit to 24-bit
promotions, down scale dithering, halftone, and diffusion of Hi-Color images. Image operations include
Copy, Paste, and Resize.

ω The images included on the CD are all vector image format.  The image manipulation features for vector
graphic images includes copy, resize, crop, original image, list components, step, and wireframe display.

Sound Features
ω Sound may be recorded or imported (WAV) and attached to any image for playback.

ω An attached audio file or clip may be replaced or rerecorded at any time allowing interactive update and
playback.

User Interface Features
ω Live, context-sensitive help, or tooltips, are displayed for each ToolBar and SpeedBar button.

ω A Full Resolution window provides image viewing and manipulation in the media library.  The manipula-
tion functions available are dependent upon the type of graphic format of the object.

ω An intuitive ToolBar provides easy access to the most commonly used features in MasterClips MediaPaq
Browser.

Key Word Search Function
ω The library search criteria can include one or more text string specifiers and can include a search of notes

that are attached to files.

ω A search can be directed to include one media library, multiple media libraries within the same directory,
or multiple media libraries in different subdirectories
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Notes
ω You may attach up to 64 Kb of notes to any image file or library icon in a media library.  These notes may

include any sort of text description or information about a particular file.  The Search feature permits you
to locate files or images using either the keyword located under each image in the thumbnail view window
or the Notes text.  All images on the CD have descriptive notes that provide keyword descriptions of the
images in each library for greater search convenience.  You may search on the Notes to locate the image
you wish by using desired keywords in the search criteria.

ω The “Notes” entry and display can be hidden from view so that you can maximize the size of the thumbnail
view window.

Windows Clipboard Support
ω MasterClips MediaPaq Browser supports both Object Linked Embedding (OLE) and Windows Clipboard

(CLP) files.



The MasterClips MediaPaq Browser Screen

2-1MasterClips MediaPaq Browser

Chapter 2
The MasterClips

MediaPaq Browser
Screen

The MasterClips MediaPaq Browser  screen is the most impor-
tant element of the graphics management system.  Understanding
what the screen contains and how to use the various features can
make using the program both quick and efficient.  It is also impor-
tant to understand that changing the resolution of the screen can di-
rectly affect MasterClips MediaPaq Browser ’s display.  For example,
if your screen is set to 640 x 480 resolution, you will be able to view
a maximum of thirty images at a time in the thumbnail view window.
However, if your screen is set to 1024 x 768 resolution, you will be
able to view a maximum of eighty-one images (plus nine half-im-
ages) at a time in the thumbnail view window.

Elements of the Screen
The MasterClips MediaPaq Browser  screen is similar to many

Windows applications in that it uses pull-down menus, button or icon
bars, status bar, and minimize/maximize controls (see Figure 2-1 on
the next page).

Let us first examine some of the elements of the MasterClips
MediaPaq Browser  screen.
SpeedBar.  When you open MasterClips MediaPaq Browser, the

screen displays the SpeedBar (see Figure 2-1).  The SpeedBar



The MasterClips MediaPaq Browser Screen

2-2 MasterClips MediaPaq Browser

Left Scroll
Button for

Media
Libraries

Media Library
Icon

ToolBar
Button

Status
Bar

Figure 2-1.  MasterClips MediaPaq Browser opens with the main menu
and SpeedBar in an empty window.  Select the media library to open from
the SpeedBar or from the Open command in the File menu.
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provides quick and easy access to media libraries that are in the
MasterClips MediaPaq Browser  system.  Each media library is
represented by a library icon that you may change as desired.
When you open a media library, the SpeedBar automatically
changes to the MasterClips MediaPaq Browser  ToolBar.  At the
left end of the SpeedBar is a ToolBar button that you may use to
open the ToolBar.

The SpeedBar serves two important functions. First, it al-
lows you to quickly open any of the media libraries in the
SpeedBar (double-click on the media library icon with the left
mouse button or select “Open” from the SpeedBar pull-down
menu).  Second, when you perform a global search, the SpeedBar

Title Bar
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Figure 2-2.  The
MasterClips MediaPaq
Browser SpeedBar includes
a “ToolBar” button, media
library icons, scroll arrow
buttons, and tooltips for the
button functions.   The me-
dia library icon can be
changed to any image from
a MasterClips MediaPaq

Browser library simply by dragging a new image to the media library icon.T
T t

Media
Library Icon

Number of
files in library

Media library
file name

shows those media libraries that contain files that meet the search
criteria.

The SpeedBar includes scroll arrows to navigate through the
media library icons and tooltips that indicate the function of the
ToolBar icon and the scroll arrows (i.e., place the mouse pointer
over the ToolBar icon and a tooltip will appear below it saying
“ToolBar.” The media library thumbnails include the name of
the library file (see Figure 2-2); the number of images or files in
the library; a sound icon indicator if a sound is attached to the
library icon; and a note icon indicator if a note is attached to the
library icon. Note that there are no tooltips for the media library
icons.

ToolBar.  When you open a media library, the MasterClips MediaPaq
Browser  display changes to the library screen with the ToolBar
(see Figure 2-3 on the next page).  The MasterClips MediaPaq
Browser  ToolBar contains icons or buttons that permit you to
quickly and easily access many of the program’s most commonly
used functions (see Figure 2-4 on the next page).  You may
access the ToolBar either by opening a media library file or by
selecting the ToolBar icon located at the left end of the SpeedBar.
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Figure 2-3.  The elements of the MasterClips MediaPaq Browser screen
(only the left half of the screen is shown above).
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Figure 2-4.  The ToolBar provides access to the most commonly used
features in MasterClips MediaPaq Browser.
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Main Menu Bar.  The Main menu bar provides access to all of the
MasterClips MediaPaq Browser  functions.  It functions the same
as any other Windows pull-down menu system.  To make a se-
lection, click on the main menu bar item and select the desired
item from that menu.

Title Bar.   The Title bar is located at the very top of the MasterClips
MediaPaq Browser  window.  The title bar displays “MediaPaq
Browser ” and the name of the current media library that is open
(if one is open).

Status Bar.  The Status bar, located at the bottom of the MasterClips
MediaPaq Browser  screen, serves a number of functions, de-
pending upon the current status in MasterClips MediaPaq
Browser  (i.e., whether a media library file is open or not) as well
as the current operation.
Record number and count.  When a media library is open and

there is no activity, the Status Bar indicates the number of the
image in the library that is currently active and the number of
images or files in that media library.

Path of current media library.   When a media library file is
open and no images are highlighted in the library window,
the Status Bar displays the path and file name for that file.
For example, when the sample media library is open,  you
will see “C:\MPX\MC_MEDIA.DCF” in the Status Bar (the
drive and directory location may be different in your computer).

Description of highlighted file.  If a media library is open in
MasterClips MediaPaq Browser  and an image or file is high-
lighted, the Status Bar displays a description of that file.  For
example, you might see:
GOALS001.WMF: 3,288/1,356 (2:1)->LZH 484 X 483 16.

The interpretation of this information is as follows:
GOALS001.WMF.  Name of the file that is currently high-

lighted.  If there is more than one file highlighted, the
Status Bar displays the information for the last file in the



The MasterClips MediaPaq Browser Screen

2-6 MasterClips MediaPaq Browser

library that you highlighted (and not necessarily the last
file in the library that is highlighted).  If you highlight
image 5, 10, and 1, the Status Bar will display the path
information for image 1.

3,288/1,356.  Original file size compared to the compressed
file size (i.e., the original file was 3,288 bytes and the
compressed version stored in MasterClips MediaPaq
Browser  is 1,356 bytes).

(2:1).  The approximate compression ratio achieved in
MasterClips MediaPaq Browser.  This is an approximate
computation.  Many times you will see “1:1” for the com-
pression ratio; this means that the compression ratio is
less then double.

LZH.   The type of data compression used on the file.
484 X 483.  The size of an image, 484 pixels x 483 pixels in

this example.
16.  The number of colors in the image file.

Horizontal Scroll Bar.  A horizontal scroll bar spans the screen above
the Status Bar.  You may use the scroll bar to scroll though the
media library thumbnail images:
ω Click on the arrows at either end of the scroll bar to scroll

one column to the left or right.
ω Click and drag the scroll bar button to the desired location.

The thumbnail view images will change according to the lo-
cation of the scroll button.

ω Click in the scroll bar (outside of the scroll button) to scroll
the thumbnail view window one screen to the left or right.

Thumbnail view window.  Most of the MasterClips MediaPaq
Browser  window is devoted to displaying the thumbnail repre-
sentations of the images or files in a media library.  The indi-
vidual thumbnail image boxes include a graphic representation
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of the content of the file as well as information about the image
or file (see Figure 2-5). The image box displays a speaker icon
indicating that a sound file is attached to the image (if any); a
notes icon indicating that a note is attached to the image (if any);
the type of compression used (if any); the amount of space the
file consumes compared to the original file size; and the file name.

Notes.  MasterClips MediaPaq Browser attaches up to 64 Kb of notes
to any file in a media library (see Figure 2-6 on the following page).
You can display the notes in the thumbnail view window all the time
or just when needed.

To turn the Notes display on or off:

1. Click on the Window menu in the Main menu bar.
2. Choose the Notes command to place or remove a check

mark by the option (a check mark by the Notes command
indicates the “Notes” will display; no check mark by the
Notes command indicates the “Notes” will not display).

TTTTTIPIPIPIPIP:  :  :  :  :  You must click on the Save button to save a note to an image. If you run out of disk
space on your hard disk, MasterClips MediaPaq Browser   cannot update the image library,
and any items added (imported images or attached notes and sound files) are ignored. Read-
only l ibrary f i les c annot be modi fied.

File Size as % of
Original Size

Type of File

Sound File
Indicator Icon

Figure 2-5.  The thumb-
nail image box displays a
thumbnail representation
of the image.

Image

File Name
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Figure 2-6.  “Notes” will
display at the bottom of the
window if you choose the
Notes command in the
 Window menu.
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Figure 3-1.  The SpeedBar fea-
tures a ToolBar icon to switch to
the MasterClips MediaPaq
Browser ToolBar and media li-
brary icons which can be used to
open media library files.

Chapter 3
The SpeedBar

  The SpeedBar Menu
MasterClips MediaPaq Browser  includes a SpeedBar for easy

access to the media libraries (see Figure 3-1).  The SpeedBar places
your commonly used media libraries in a row of buttons or icons
across the top of the window.

To open a media library in the SpeedBar:

ω Double-click on media library icon in the SpeedBar.
OR

ω Click on the media library icon to highlight it, right-click
the library icon to open the drop-down menu, and select the
Open command.

When you load MasterClips MediaPaq Browser, the SpeedBar
opens showing you the media libraries that you have placed in
MasterClips MediaPaq Browser.

The SpeedBar includes a ToolBar button with which you can
quickly call the MasterClips MediaPaq Browser  ToolBar.  The
SpeedBar also features tooltips that indicate the function of the buttons in the SpeedBar, such as scroll arrows
and the ToolBar button.

To open the SpeedBar menu:

1. Click once on media library icon in the SpeedBar to select it.
2. Right-click on the media library icon to open the drop-down menu.

The SpeedBar drop-down menu provides quick access to a number of functions you may use on any of the
media libraries including:

Open.  The Open command opens the selected media library.

Info/Notes.  The Info/Notes command provides information about the selected media library.

Play. The Play command plays any sound clip that is attached to the selected media library.

Record.  The Record command lets you record or import a sound clip to attach to the icon for that media
library.
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Transfer.  The Transfer command permits you to transfer highlighted or all of the records in the selected
media library to another media library.  A dialog box permits you to select the destination library file name.

NNNNNOTEOTEOTEOTEOTE:::::  The transfer operation transfers sound files and notes that may be attached to images or files that are being transferred.  If you wish to
transfer only selected files, you must open the desired library, highlight the files that you wish to transfer, switch to the SpeedBar, and select
"Transfer" f rom t he pul l -down l i brary menu f or t hat media l i brary.  A t t he end o f t he t ransfer, MasterClips MediaPaq Browser  asks i f y ou wish
to r emove t he f i l es f rom t he original  l i brary f i l e t hat were t ransferred t o t he new f i le.

Print Catalog.  The Print Catalog command permits you to print a catalog of images in a media library.  If
the media library is not open or if there are no images selected in the media library, the option prints a
catalog of all images in the media library.

Delete Library.  The Delete Library command deletes the selected media library from the disk drive and
removes the media library icon from the SpeedBar.

Hide Thumbnail.  The Hide Thumbnail command removes the media library icon from the SpeedBar, but
does not remove the media library file from the disk drive.  If you wish to place the media library icon in
the SpeedBar after it has been hidden, you may do so when you open the media library file.

The ToolBar Icon
The left end of the SpeedBar features a ToolBar icon that provides quick access to the MasterClips MediaPaq

Browser  ToolBar (see "Chapter 4: The ToolBar" for more information on the ToolBar features).  Click on the
ToolBar button to change from the SpeedBar to the ToolBar.

Another feature of the SpeedBar, as well as the ToolBar, are tooltips that tell you the function of each
button in the SpeedBar and ToolBar.  Place the mouse pointer on the ToolBar icon or a scroll arrow button, and
an tooltip box will open indicating the purpose of that button.  The individual media library icons do not have
tooltips boxes.

Scrolling in the SpeedBar
The SpeedBar includes Scroll Arrow buttons that permit you to scroll through the media library icons in

the SpeedBar.  If there are more media libraries in your MasterClips MediaPaq Browser  directory than can fit
in the SpeedBar, you may use the left and right scroll arrow buttons to scroll through the media library icons.
If the number of media libraries
does not fill the SpeedBar, the
scroll arrow buttons have no effect.

Customized Media
Library Icons

When you create a new me-
dia library in MasterClips MediaPaq Browser, the SpeedBar defaults to the standard media library icon.  How-
ever, MasterClips MediaPaq Browser  provides the ability to assign any image to the SpeedBar for a media
library (see Figure 3-2).  This feature permits you to customize the appearance of the SpeedBar for maximum
convenience and efficiency.

To assign a custom icon to the SpeedBar:

1. Open a MasterClips MediaPaq Browser media library.
2. Locate the image that you wish to assign to the SpeedBar.  The image you select does not have to be

in the media library in which you wish to use it.  For example, you may select an image from one

Figure 3-2.  You can customize the SpeedBar media library icons to
have a graphic image icon rather than the standard MasterClips MediaPaq
Browser media library icon.

Media Commander Express
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media library and assign it as the SpeedBar icon to another me-
dia library.

3. Click on the image you wish to assign to the SpeedBar, and, while
holding down the left mouse button, drag the image to the media
library icon that you wish to replace (see Figure 3-3 on the fol-
lowing page).  When you have the image over the current media
library icon, release the mouse button.

4. Answer "Yes" to the prompt to replace the media library icon
with the new image.  That image is now assigned as the SpeedBar
icon for that media library.

SpeedBar images should be selected for clarity and easy recognition.
For example, highly detailed, scanned images, such as photographs, may
not be large enough to use as library icons.

Turning Off the SpeedBar
When you open a media library, the SpeedBar is replaced by the ToolBar.

You may turn the SpeedBar and ToolBar on and off, using the SpeedBar command in the Window menu.
To turn the SpeedBar and ToolBar feature off:

1. Click on the Window menu in the Main menu.
2. If there is a check mark next to the ToolBar/SpeedBar command, then the SpeedBar and ToolBar are

active.  Click on the ToolBar/SpeedBar command to remove the check mark and turn the SpeedBar
and ToolBar off.

The ToolBar/SpeedBar command in the Window menu toggles both the SpeedBar and the ToolBar on or
off.  There is no method for turning  the SpeedBar or the ToolBar on or off individually.

Figure 3-3.  To insert a new
image in place of a media
library icon, click once on an
image to highlight it, and then
click and drag the image to the
media library icon.  When the
new image is over the media
library icon, release the mouse
button.
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Chapter 4
The ToolBar

ToolBar
MasterClips MediaPaq Browser features a ToolBar that provides easy access to the most commonly used

functions (see Figure 4-1).  This ToolBar appears at the top of the MasterClips MediaPaq Browser window
when a media library is open or when you click on the ToolBar button in the SpeedBar.  In this chapter we will
examine each button in the ToolBar.  The buttons are displayed in the left margin for each section for easy
reference.

This chapter is intended to present an overview of the ToolBar features.  See Chapter 5 for more a detailed,
step-by-step tutorial on how to use the various features in the ToolBar.

SpeedBar
The SpeedBar button

permits you to switch from
the ToolBar to the SpeedBar
so that you may open an-
other media library.  Click
on the SpeedBar button once
to display the ToolBar.  Click
on the ToolBar button in the
SpeedBar to return to the
ToolBar.

New File
The New icon permits

you to create a MasterClips
MediaPaq Browser  media
library file (a file that ends
with an extension of
“.DCF”).  MasterClips
MediaPaq Browser  uses the
media library files to store
images and data files.  The
thumbnail view window in
MasterClips MediaPaq
Browser  permits you to
view graphical representa-
tions of the files in each me-
dia library.  The graphical

SpeedBar Open File

Show
Window

Import
Files

Print

Copy to
Clipboard

Delete

Search Play

Record Zoom
Out/In

Regenerate
Images

End of
File

Previous
Page

Next
Page

Top
of File

New File

Figure 4-1.  The MasterClips MediaPaq Browser ToolBar provides access
to the most commonly used features in the program:

SpeedBar.  Changes from the SpeedBar to the ToolBar.

New File.  Create a new media library file.

Open File.  Opens an existing media library or Zip file.

Show Window.  Opens a full resolution window for all highlighted images.

Import Files.  Brings graphic or document files into MasterClips MediaPaq Browser.

Print.   Prints selected images in the media library.

Copy to Clipboard.  Transfers the highlighted image into the Windows Clipboard so
that it can be inserted into another Windows application.

Delete.  Deletes all of the highlighted images or files in a media library.

Search.  Searches a media library or multiple libraries for specific search criteria that
you enter.

Record.  Records a sound that may be attached to any image or file in a library.

Play.  Plays all sound files or animation files that are currently highlighted.

Zoom Out/In .  Increases/decreases the size of the individual thumbnail window image
display.

Regenerate Images.  Feature is not active in MasterClips MediaPaq Browser.

Top of File.  Moves the cursor to the beginning of the current media library.

Previous Page.  Moves the cursor to the previous screen in the current media library.

Next Page.  Moves the cursor to the next screen in the current media library.

End of File.  Moves the cursor to the end of the current media library.
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representations are either a small version of the image (for image files) or an icon representation of the content
of a particular non-graphic file.

To create a new media library file:

1. Click on the New button in the SpeedBar.
2. Enter the name for the new media library file.
3. Select the location (drive and directory) to open the file.
4. Click on the OK button.

Open File
The Open file icon permits you to open an existing media

library file.  When you click on the Open button,  MasterClips
MediaPaq Browser  opens the Select a Library dialog box from
which you can select a library file to open (see Figure 4-2).

You can also open media libraries using the media library
icons in the SpeedBar.  The Open button in the ToolBar is
useful for opening a file that is not in the SpeedBar.

To open a file:

1. Click on the Open button in the SpeedBar.
2. Select the location (drive and directory) to open the

file.
3. Double-click on the library file name that you wish to open.
4. Click on the OK button.

Show Window
MasterClips MediaPaq Browser  displays images in a thumbnail view win-

dow (see Figure 4-3).  The program features a “Full Resolution Window” or
“Show” window that, when open, shows the image in greater detail.  In addition
to the larger size and greater detail, the “Full Resolution” window includes a
menu bar with which you can select options to manipulate the image (convert to
copy, resize, etc.).

You must have at least one image highlighted to use the “Show” window
feature.  If you have more than one image highlighted, the Show button will
open a “Show” window for each image.  These images will be superimposed
one on top of the other.

To open a “Show” window using the ToolBar:

1. Click on an image to highlight it.
2. Click on the Show button in the ToolBar.
3. Choose the File|Close menu to close the “Show” window.

Another method of opening a “Show” window is to double-click on an image in the thumbnail view window.

Figure 4-2.  The Select a Library dialog
box permits you to select the desired media
library to open.

Figure 4-3.  The “Show”
or “Full Resolution” win-
dow displays the image in
greater detail.
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Figure 4-4.  The Image
Import Utility dialog box
permits you to select image
or document files to add to
a media library.

Figure 4-5.  The Storage
Method... dialog box per-
mits you to tailor the file
storage parameters to your
needs.

Import Image
The Import button permits you to bring images and data files into a  MasterClips MediaPaq Browser

media library file.  This process adds files to a media library and, if desired, compresses the data in the
libraries.

One important consideration in importing files into a library is selecting the correct import filter.  An
import or export filter is a tool that MasterClips MediaPaq Browser  uses to convert a file from one format to
another when importing or exporting.

The “List Files of Type” selector is especially useful when you wish to import files of a particular type
only.  For example, you may wish to import PCX files from a directory that contains different types of bit-
mapped and vector format files.  When you set the import filter to “PC Paintbrush (*.PCX),” only the “PCX”
files will display in the “File Name” list box.  This will simplify the process of selecting the PCX files to
import.

To import images using the ToolBar:

1. Open a media library file.
2. Click on the Import button in the ToolBar.
3. Select the follow-

ing options in the
Image Import Util-
ity dialog box (see
Figure 4-4):
A. The desired file

format in the
“List Files of
Type” list box.

B. The location of
the files (i.e., drive and directory).

C. The files that you wish to import.  You may hold down the Ctrl
key and highlight files in succession or use the Select All but-
ton to select all supported files in a directory.

4. After you have selected the files to import, the Storage Method...
dialog box opens in which you may select the following storage
parameters (see Figure 4-5):
A. Global Keyword.  A word or short phrase (a maximum of 20

characters) that will be appended to the “Notes” of each file
imported in the import operation.

B. The compression technique desired.
C. Whether or not to destroy the original files when they are imported.

5. When you have selected all of the desired options, click on the OK
button to begin importing the files.
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Figure 4-7.  The Print Layout
dialog box permits you to tai-
lor the printout to your speci-
fications.  You can print one
image to a page, one image to
a half-page, a catalog with
“Notes,” or a catalog without
“Notes.”

Catalog printout without detail. Catalog printout with detail.

Figure 4-6.  MasterClips MediaPaq Browser features a number of
different printout options that yield different printed results.

Full-page printout. Half-page printout.

Print
MasterClips MediaPaq Browser

features a number of print options
with which you may print images in
a media library (see Figure
 4-6).

To print one or more files in
MasterClips MediaPaq Browser:

1. Click on an image to high-
light it.  If you wish to print
more than one image, hold
down the Ctrl key and
click on all of the images
you wish to print.

2. Click on the Print button
in the ToolBar.

3. In the Print Layout dialog
box, select from these op-
tions (see Figure 4-7):

A. Full Page.  One image
to a page.

B.  Half Page.  One image
to a half page with file
information and “Notes.”

C. Catalog with the “De-
tailed” option se-
lected.  Catalog of im-
ages with file informa-
tion and “Notes.”

D. Catalog without the
“Detailed” option se-
lected.  Catalog of im-
ages with file name
only.

Copy to Clipboard
Using the Windows ”Clipboard”

is one of the easiest methods of plac-
ing single image files from
MasterClips MediaPaq Browser
into another Windows application.
The process is simple, efficient, and
works with a wide variety of Win-
dows applications.  You can use the
“Clipboard” icon or the image menu
option to place images in the Windows “Clipboard.”
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NOTE: The ”Clipboard” transfer works only with graphic files; it does not work with non-graphic files such as word processor files.

Basically, the “Clipboard” transfer uses the following steps:

1. Click on an image in a media library to highlight it.
2. Click on the “Clipboard” icon.
3. Go to the application in which you wish to use the image.
4. Press Ctrl + V or choose the target application’s Paste command to place the image in the application.

NOTE: Different applications have different requirements for “Clipboard” transfer.  For example, some applications require that you create a document
in the application before you can insert an image.  Other applications require that you create an image box before you can insert an image into
a document.  If you are not sure about the application to which you wish to transfer the image, check the user guide or tech support for that application.

Delete File
Deleting an image or file in a media library is a simple process.  To delete an image or file, click on the

desired file or files, and then click on the Delete key.  MasterClips MediaPaq Browser  has no “Undelete”
function.

Search
One of MasterClips MediaPaq’s most powerful features is the

“Search” capability.  When you click on the Search button, the Li-
brary Keyword Search dialog box opens for you to enter the search
criteria (see Figure 4-8).  The “Search” function offers these options:

A. Enter search criteria (i.e., the information for which you wish to
search).

B. Search on multiple criteria by adding “and” and “or” operators
to the search criteria.

C. Search “Notes.”
D. Search for “Whole Words Only” or for partial words.

TIP: If you do not check the “Search whole words only” option in the Search dialog box,
it will search all images for partial matches. For example, if your search criteria is “US” and you do not select “Search whole words only,” MasterClips
MediaPaq Browser will display images with “USa,” “brUSh,” and “hoUSe” as matching the search criteria.

E. Conduct a search on the media library that is currently open or do a global search on all libraries in a
directory.

F. Save the search criteria for future use.
G. Enter the text in both upper and lower case; the search function is non-case sensitive.

When you conduct a search, the SpeedBar display of media library icons will be limited to only those
libraries that contain files that match the search criteria.  This permits easy selection of the libraries that
contain the files for which you are searching.

Figure 4-8.  The Library Keyword
Search dialog box permits you to
enter the criteria for your search.
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Record
You may record or import a sound file or sound clip and insert it

into a media library or attach it to an image or file in a media library.
When you click on the Record button, MasterClips MediaPaq Browser
opens the Attached Sound Manager dialog box (see Figure 4-9):

A. Import . Import a sound file.
B. Export . Export a sound file or clip.
C. Delete.  Delete a sound clip that is attached to an image or file.
D. Record.  If your computer is equipped with an optional sound card

that is compatible with Windows and you have an optional micro-
phone or line-in connection, you may record a sound clip to insert
or attach to a file in a media library.

E. Stop.  Stop recording input.
F. Pause.  Pause the recording input.
G. Play.  Play the sound that is attached to the image or file.
H. Sound clip size and playback progress clock that provides a visual indication of the amount of disk space

available as you are recording or the progress of a sound clip playback.

Play
The Play button plays an animation file, a sound file, and sound files that may be attached to images or

data files in a library.  To select a sound clip to play, click on the image or file in the thumbnail view window
and then click on the Play button.  If you click on one file to highlight it and then click on the Play button, any
video file, sound file, or sound clip that is in the highlighted file is played.  If you highlight multiple files and
click on the Play button, all of the video files, sound files, and sound clips that are attached to files will play in
sequence.

Zoom Out/In
When you create a new media library, MasterClips MediaPaq Browser  defaults to the smallest possible

size for the display in the thumbnail view window (the smallest thumbnail display is 64 pixels x 48 pixels).
Displaying the thumbnail images at the smallest size lets you view more images at one time.  With certain file
types, it is desirable to increase the size of the thumbnail images so that you can see them more clearly.

The Zoom Out/In button permits you to increase or decrease the size of the thumbnail images in the
thumbnail view window.  To reduce the size of the thumbnail image in the media library, click on the minus
(i.e., “-”) portion of the Zoom Out/In button or press the - key.  To increase the size of the thumbnail image in
the media library, click on the plus (i.e., “+”) portion of the Zoom Out/In button or press the + key.  You may
continue click on the desired button until the thumbnail view reaches the smallest or largest display size (a bell
will indicate when you have reached the minimum and maximum display sizes).

If desired, you may store the media libraries in a size that you select with the Zoom Out/In button.  If you
wish to store the media libraries in the size you select, you must set the storage option in the Preferences dialog
box.

Regenerate Images
When you resize images in a media library, you will notice that the quality of the image degrades with each

size change.  Changing from the smallest size to the largest size generally yields a thumbnail view image that

Figure 4-9.  The Attached
Sound Manager dialog box fea-
tures controls for recording, im-
porting, and playing sound clips
in a media library.
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is illegible.  To restore the image quality, you must regenerate each image using the following procedure:

1. Click on an image to highlight it.
2. Right-click on the image to open the pull-down menu.
3. Choose on the Regenerate command in the pull-down menu.

Repeat the above steps for each image that you wish to regenerate.

Top/End of File
The MasterClips MediaPaq Browser  ToolBar includes four buttons to assist you in navigating through the

media libraries.  The four navigation buttons appear at the right end of the ToolBar.  The first navigation button
is the Top of File button (the button points to the left).  Click on the Top of File button to move the cursor to the
first image or file in a media library.

The button at the right end of the ToolBar is the End of File button.  Click on this button and the cursor will
move to the last image or file in the media library.

Previous/Next  Page
The Previous Page and Next Page buttons move the screen display backward or forward in the media

library one screen at a time.
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Figure 5-2.  The media library
menu provides quick access to a
number of library related functions.

Chapter 5
Tutorial:

Basic Functions

Introduction
In this section we will go through a tutorial on how to use MasterClips MediaPaq Browser. We will cover

the basics of how to use the SpeedBar and the important features of the media libraries.

Opening a Media Library
When MasterClips MediaPaq Browser opens, it first displays the SpeedBar with the icons of any media

libraries that are in the system.  Each media library icon features a menu with which you may perform certain
functions upon the library.  Right-click the media library icon to open the Library menu (see Figure 5-2).

To open a media library:

1. Click on a media library icon to highlight it. The name under
the library icon will change color indicating that it is
highlighted.

2. Right-click on the library icon to open the Library menu.
3. When the Library menu opens, click on the Open command

to open the media library.  An alternative is to double-click a
media library icon to open that library.

When the media library opens, you will be viewing the thumbnail
view window for that library.  When you are viewing a media library
thumbnail view window, the SpeedBar is replaced by the ToolBar.  The MasterClips MediaPaq Browser
ToolBar features functions that are most commonly used in media libraries.

Navigating in a Library
One of the most important aspects of learning to use the MasterClips

MediaPaq Browser  libraries is how to navigate or move through them.
MasterClips MediaPaq Browser  offers a number of different methods
to go to different files in a library (see Figure 5-3).

w Top of File and End of File buttons in the ToolBar.
w Previous Page and Next Page buttons in the ToolBar.

w Horizontal Scroll bar across the bottom of the MasterClips MediaPaq

Figure 5-3.  The ToolBar in-
cludes library navigation but-
tons to help you move through
the library.

Previous Page and
Next Page icons

Top of File and End
of File icons
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Browser  window.
w Use the Page Down/Page Up buttons to go from one screen to another.

Selecting Images
You must select or highlight images in the thumbnail view window before you can perform any operations

upon them.  To select an image in the window, click on the image once.  You will notice that when you click on
an image, the keyword or file name below the image or icon changes to display in reverse video indicating that
it is highlighted.  Other options for highlighting files are

w Hold down the Ctrl key while you click additional image icons in the library to highlight more than
one image.  It is not necessary that you select the images in any particular order.

w Hold down the Shift key to select consecutive images or files only.

The Show Window
MasterClips MediaPaq Browser  features a “Show” window that,

when open, displays the image in full resolution (see Figure 5-4).  In
addition to the larger size and greater detail, the “Show” window in-
cludes a menu bar with which you can select options to manipulate the
image (convert to grayscale, resize, etc.).  The manipulation options
available differ with the each type of file in the library.  There is no
“Show” window for sound files in a library.

You must have at least one image highlighted to use the “Show”
window feature.  If you have more than one image highlighted, the Show
button will open a “Show” window for all of the images that are high-
lighted.   When MasterClips MediaPaq Browser  opens “Show” windows for more than one image, it superim-
poses the windows one on top of the other.

To open a “Show” window using the ToolBar:

1. Click on the first image in a media library icon to highlight it.
2. Click on the Show button in the ToolBar.
3. Choose File|Close in the “Show” window. Be sure that you do not click on the File menu in the Main menu.

Manipulating an Image
To manipulate an image:

1. Click the Show button in the Toolbar.
2. Click and drag the mouse around the image, creating a box around the image.
3. Choose Edit|Crop from the Show window menu. A new window will open displaying the cropped

image along with additional menu options.)
4. Manipulate the bitmapped image using the Orient, Attributes, Process, and Color menus.

TIP: Copy the edited image into a target application by selecting Edit|Copy in MediaPaq Browser and then selecting the Paste command in the
target application.

Figure 5-4.  The “Show” window
displays an image in greater
detail.
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Creating a New Library
The next step in the tutorial will be to cre-

ate a new media library.  The easiest method
to create a new library is to use the New but-
ton in the ToolBar with the following procedure:

1. Click on the New button in the
SpeedBar to open the “Create New
Library” dialog box (see Figure 5-5).

2. Enter the name “TEST” for the new
media library file.  File names may
not exceed 8 characters plus an ex-
tension of “.DCF.”  It is not neces-
sary to add the “.DCF” extension in
the “File Name” box.

3. Accept the default file type, “DCF” in the “List Files of Type” selector.
4. If the default drive location is your CD drive, you will have to enter a new drive location.  If the

default drive is your hard drive, you may accept the location (drive and directory) as the MasterClips
MediaPaq Browser  directory.

5. Click on the OK button.

The new media library opens with a blank thumbnail view window ready to accept images (see
Figure 5-6).

Navigating Between Open Libraries
When you have a media library open and you create a new media library, the new library opens on top

hiding the previous library from view.  MasterClips MediaPaq Browser  offers a number of options with
which to move between libraries.

To move between two or more media libraries:

1. Click on the Window menu in the Main menu.
2. You will notice that the last two items in the Window menu are the current media libraries that are

open.  To switch from one library to the other, click on the file name in the Window menu.

Figure 5-5.  The Create New Library dialog box per-
mits you to create a new media library file in the disk
drive and directory of your choice.  Enter the name of a
file of no more than 8 characters.

Figure 5-6.  When you create a
new media library, it opens with
a blank thumbnail view window
as shown at left.
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Another method to access both libraries is to click on the “Window” option in the MasterClips MediaPaq
Browser Main menu:

1. Click on the Cascade command in the Window menu.
2. You will notice that both library windows are now slightly offset and visible in the MasterClips

MediaPaq Browser window.  Click on the desired library to bring it to the foreground.

Another method of accessing more than one library is to choose Window|Tile from the Main menu.  Both
libraries are now open side by side for easy viewing.

Copy to Clipboard
Using the Windows “Clipboard” is the easiest method to place single image files into another Windows

application from MasterClips MediaPaq Browser.  The “Clipboard” transfer works only with graphic files; it
does not work with non-graphic files such as word processor files.

To transfer a graphic image into the Windows “Clipboard:”

1. If you do not have a choosen media library open at this time, select one by double-clicking its cat-
egory icon.

2. Click on an image in the library to highlight it.
3. Click on the “Clipboard” button in the SpeedBar.  (An alternative method of placing an image in the

Windows “Clipboard” is to right-click the image icon to open the image menu.  When the image
menu opens, choose the Copy command in the Edit menu.)

To test the “Clipboard” transfer, you can now start a Windows application and paste the image into it. Both
MasterClips MediaPaq Browser and your target application should be open.

To copy an image into a Windows application:

1. If your target application’s window is not active, press Alt + Tab to move from MasterClips MediaPaq
Browser to the target application.

2. Choose the Paste command in the target application. The graphic you copied in MasterClips MediaPaq
Browser should now appear in the target application.

Different applications have different requirements for “Clipboard” transfer.  For example, some applica-
tions require that you create a document in the application before you can insert an image.  Other applications
require that you create an image box before you can insert an image into a document.  If you are not sure about
the application to which you wish to transfer the image, check the user guide or tech support for that
application.

Drag-and-Drop Images
If you have two or more media libraries open side by side, you can drag-and-drop images between them.

While the “Tile” function in MasterClips MediaPaq Browser   makes this operation simple, the process of
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drag-and-drop works the same for taking images from MasterClips MediaPaq Browser  libraries to other
Windows applications.  The primary difference between the drag-and-drop within MasterClips MediaPaq
Browser is that you can move more than one image at a time between MasterClips MediaPaq Browser  librar-
ies.  When you are using the drag-and-drop operation from a media library to another Windows application,
you can only drag one image at a time.  The drag-and-drop feature is most useful in those situations in which
you must transfer more than one file from MasterClips MediaPaq Browser  to another application.  Although
you must drag the images one at a time to the other application, you can quickly transfer a number of images
using drag-and-drop.  If you are transferring only one image to another application, you should use the Win-
dows “Clipboard” transfer which does not require the time to set up the application screens in Windows (see
page 5-8 for information on the “Clipboard” transfer function).  *

NOTE:  You cannot perform drag-and-drop operations between image libraries on a CD.  The CD is a read-only device that does not permit modification
of the libraries or images in any way.

To drag images between media libraries use the following procedure (to perform this operation, you will
need two libraries open, a source library, from which you are dragging the images, and a target library, to
which you are dragging the images):

1. In the source media library, click on one image to highlight it.  You will notice that the mouse pointer
becomes a “No-drop” icon.

2. Click and drag the image to another media library (i.e., the target library).  When the mouse pointer
is over the target library, the mouse pointer becomes the “Drop icon.”

3. When the mouse pointer becomes the “Drop icon,” release the mouse button to place the image in
the target library.

Dragging Images to Other Windows Applications
MasterClips MediaPaq Browser  supports drag-and-drop to Windows applications that support Object

Linked Embedding (OLE) transfers.
To perform a drag-and-drop operation between MasterClips MediaPaq Browser  and another Windows

application, you must have MasterClips MediaPaq Browser  and the target application open and visible on the
screen at the same time.  This requires that you resize the screens for both applications. You should be able to
see both MasterClips MediaPaq Browser  and the target application on the screen at the same time.

To drag-and-drop an image to another Windows application:

1. Load the target application in which you wish to place the images.
2. Size MasterClips MediaPaq Browser’s window and the target applicaiton’s window so that they can

be viewed side by side.
3. Click an image in MasterClips MediaPaq Browser to select the image you want to transfer.
4. Click and drag the image to the target application’s window.  When the mouse pointer is over an area

that will not accept a drag-and-drop transfer, the mouse pointer is a “No-drop” hand icon.  When the
mouse pointer is over an area that will accept a drag-and-drop transfer, the mouse pointer becomes a
“drop” hand icon.

5. A dialog box will prompt you “Attempt to ‘paste’ object? (default is to insert package).”  The prompt
refers to the method in which the target application handles OLE transfers.  Some applications re-
quire that you answer “Yes” to the prompt; other applications require a “No” response.  Since there
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are so many different Windows applications, it is impossible to provide a definitive list of what the
correct response is for each.  You should try experimenting with a drag-and-drop transfer answering
first “Yes” and then “No” to see which gives you the best results in an application.

TIP: Some applications are limited in their ability to import different graphic types.  For example, Windows “Paintbrush” can only accept bitmapped
images (and not vector graphics).  If you try to drag a vector graphic (such as a “.CGM” file) into “Paintbrush,” you will get a “Paintbrush” error
message: “Not able to open this file because the format is not recognized.  Create a new file or open a valid bitmap image file.” However, if you
copy an image in MasterClips MediaPaq Browser, you can import the copied image by using the Paste command in most applications.

The drag-and-drop to other Windows applications supports the transfer of only one image at a time.  The
drag-and-drop feature is most useful when you need to transfer a number of images one at a time from
MasterClips MediaPaq Browser  into a target application.

If you wish to transfer only one image from MasterClips MediaPaq Browser  to another Windows applica-
tion, it is best to use the Windows “Clipboard” transfer.  Because of the time needed to set up the MasterClips
MediaPaq Browser  and target application screens, the drag-and-drop feature is most useful only when you
need to transfer a number of images into one target application.

Closing a Media Library

When you close a media library, MasterClips MediaPaq Browser  performs a number of housekeeping
operations that are designed to keep the libraries operating a peak efficiency.  One of these operations is to
purge any deleted files from the library and compress the library file to its optimum size.  The purging of the
library file takes a brief amount of time when you are closing a library or exiting MasterClips MediaPaq
Browser.  It is important that you close or exit the media libraries properly to prevent any damage to the
data files.

To close a media library:

1. Click on an image inside a media library window to make it the active library.
2. Choose File|Close in the Main menu.

OR
1. Click on an image inside a media library window to make it the active library.
2. Double-click on the “Control Menu Bar” in the “TEST” library window to close the library in Win-

dows 3.1 or click the Close button in the library window’s upper-right corner in Windows 95.

Hiding a Media Library Icon
MasterClips MediaPaq Browser  inserts a library icon in the SpeedBar for each library that you open.  If

you decide that you don’t require certain libraries very often, you may remove the library icon from the
SpeedBar without deleting the library from the hard disk drive.  The library will still be available by selecting
the File|Open in the Main menu, but it will not appear in the SpeedBar until you open it again using the “Open”
option in the “File” menu.

To hide a library icon:

1. Click on a media library icon to highlight it.
2. Right-click on the library icon to open the media library menu.
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3. Click on the “Hide Thumbnail” option in the media library menu.

Opening a Library Without a Library Icon
If you wish to open a media library for which there is no library

icon in the SpeedBar, you must use the “Open” option in the “File”
menu.  There are several reasons why a library may not have an icon:

A. You chose to hide it in the SpeedBar.
B. You copied the library from another directory or computer.
C. You had to reinstall MasterClips MediaPaq Browser.
D. You transferred files to another library file using the library

icon pull-down menu.
E. You used the “Copy to” option in the “File” menu to make a

copy of a library file.

To open a library when the library does not have an icon in the
SpeedBar:

1. Choose File|Open in the Main menu. The Select Library to Open dailog box will appear (see Figure 5-7).
2. In the “File Name” list box, double-click on a library to open it.

Importing Images
In this operation, we will use the “Import” button in the ToolBar to

import images.  You will need to have a media library open that has no
more than 24 images in it to perform an import operation.  In addition,
the media library for import must be on your hard disk drive.

1. Click on the Import button in the ToolBar.
2. Click on the arrow to the right of the “List Files of Type”

selector in the Image Import Utility dialog box (see Figure 5-8).
3. Scroll to the “All Bittmapped Graphics” option in the “List

Files of Type” list box and click on it to highlight it.  All of the vector files in the MasterClips
MediaPaq Browser  directory are now listed in the “File Name” list box.

 4. Select a number of files in the in the Image Import Utility dialog box.
5. Click on the OK button to proceed with the import operation.
6. When the Storage method. . . dialog box opens, you should enter or select from the following options:

A. Global Keyword.  A word or short phrase (a maximum of 20 characters) that will be appended
to the “Notes” of each file imported in the import operation.

B. Compression technique to use.  MasterClips MediaPaq Browser  offers a number of different
compression methods.

C. Destroy original files.  When there is an “X” in the status box for this option, the original files
will be deleted after they are imported into a media library.

Figure 5-7.  The “Select Library
to Open” dialog box permits you
to open a media library file in the
disk drive and directory of your
choice.  Enter the name of a file to
open or double-click on the file
name in the file list box.

Figure 5-8.  The Import Image
Utility dialog box permits you to
select the files, types of files, disk
drive, and directory locations of
files to import.



Tutorial: Basic Functions

5-8 MasterClips MediaPaq Browser

WARNING: Make sure that you have an archived copy of the files you are importing before you elect to delete them.  If you import the files into
MasterClips MediaPaq Browser  and do not have an archive copy of the files, you will be totally dependent upon the MasterClips MediaPaq Browser
library for those files.  If your hard disk requires reformatting or if the media library becomes corrupt, the files in the media library will be lost.
It is imperative that you make an archive copy of all important files that you wish to keep before you import using the “Delete original”
option.

7. When all of the desired options are correct, click the OK button to import the files.

Deleting an Image or File from a Library
To delete an image or file, click on the desired file or files, and then click on the Delete button in the

ToolBar.
To delete several images from a library:

1. Hold down the Ctrl key while you click on the images one at a time in the media library to highlight
them.

2. Click on the Delete button in the ToolBar (or press the Del key).
3. Click on the Yes button to confirm the deletion.

The Delete feature does not function with media libraries on a CD or media libraries that are designated as
read-only.

WARNING:  An undelete function is not available in MasterClips MediaPaq Browser.

Close a Library
At this point in the tutorial, we will close the current library file.
To close a library file:

w Choose File|Close in the Main menu.

Deleting a Media Library
There are a number of different methods with which you may remove a media library from your hard disk.

We will list the different methods separately in the following operations.  You may follow the steps removing
the libraries or you may leave the libraries intact for future use.  You should close all media libraries before
you use any of the library delete functions.

To Delete a media library with the Media Library Menu:

1. Click on a media library icon to highlight it (this library must not be on a CD).
2. Rigt-click on the library icon to open the media library menu.
3. Choose the Delete Library command in the media library menu.
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4. Click on the Yes button to confirm the deletion of the library.

To Delete a media library with the Delete Button in the “File | New” or “File | Open” Menu Options:

1. Choosee File|New or File|Open in the Main menu.
2. Click on a file in the “File Name” list box that you wish to delete.
3. With the file name highlighted, click on the “Delete” button (this file must not be on a CD).
4. Click on the OK button to confirm the deletion.
5. Click on the “Close” option to close the dialog box.

Printing
The Print command permits you to print copies of images from a media library.  There are a number of

possible print options from which you may select. (See also “Print” in Chapter 4, illustrating the print options.)
When you select the Print command in the File menu, MasterClips MediaPaq Browser  opens the Print

Layout dialog box.  The Print Layout dialog box permits you to tailor a print job to your requirements, includ-
ing the following options:

Paper Window.  The “Paper Window” illustrates how an image will appear on a sheet of paperwhen
printed.
Picture.  This option allows you to modify the size and location of the picture on the page.  For example,
when the “Picture” button is selected, you can use the mouse pointer to redraw the picture size and location
in the “Paper Window.”
Notes.  This option modifies the location of the file name and “Notes” on the page.  When the “Notes”
button is selected, you can use the mouse pointer to redraw the notes size and location in the “Paper
Window.”
Maintain Aspect Ratio. This option keeps the dimensions of the image the same without distorting the
image.
Catalog.  The “Catalog” option permits you to select a catalog printout.  If any images are highlighted,
they will be printed in the catalog.  If no images are highlighted, all of the images in the library will be
included in the catalog printout.
Detailed.  If the “Detailed” option is selected (i.e., there is an “X” in the status box), the catalog will print
will file name, original path, “Notes,” etc.  This option prints a column of images down the left side of the
page with the file name, original path, and “Notes” to the right of each image.  If this option is not selected
(i.e., there is not an “X” in the status box), the catalog will print whatever number of images to a page that
are selected in the “Per Page” selector (see item “I” below).
Print.  This button starts the printing process.
Optimize for Speed.  If this option is selected (i.e., there is an “X” in the status box), the catalog will print
faster while sacrificing print quality.  This option is the equivalent of the “Print to port” option in the
Windows “Print Manager.”  The feature by-passes the Windows “Print Manager” and prints directly to
your computer’s printer port.
Per Page selector.  This scroll bar permits you to select the number of images per page when printing a
catalog that is not “Detailed.”  Use the scroll arrows to select the number of images per page.
Image selector.  You can use the image selector scroll bar to view the highlighted images one at a time.  If
no images are highlighted, this feature does not function.
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Half Page.  This button selects the option to print the image on a half page with the file name, path
information, “Notes,” etc.
Full Page.  This button selects the option to print the image on a full page.

TIP: If you wish to print the images with notes, you must use the “Half Page” option or “Thumbnail Catalog”  with “Detailed” options.

Setup.  This button accesses the printer setup option in MasterClips MediaPaq Browser.
Select Printer.  The currently selected printer is displayed at the top of the “Select Printer” dialog box.

The print function prints only graphical images that are in a media library.  Non-graphical files, such as
word processor files, program files, help files, etc., are represented in a printout by the standard file type icon
that is displayed in the thumbnail view window.

To print images in a media library:

1. If you wish to print a complete catalog of images in a media library, it is not necessary to have any
images highlighted when you select the “Print” option.  However, if you wish to print a partial
catalog of selected images, print images in full-page size,  or print images in half-page size, you must
have the desired images highlighted before you access the “Print” function.  To highlight an image,
click on an image in the thumbnail view window.  If you wish to highlight more than one file, hold
down the Ctrl key while clicking on each file you want to highlight.

2. Click on “File” in the menu bar.
3. Click on “Print” in the “File” menu to open the Print Layout dialog box.
4. Select a desired printout type from the Print Layout options:

A. Print one image to a page (i.e., “Full Page” printout).
(1) Highlight the images you wish to print.
(2) Click on the Full Page button.
(3) Make sure that the “Maintain Aspect Ratio” option has an “X” in the status bar to prevent

image distortion.
B. Print one image to a half-page with “Notes” (i.e., “Half Page” printout).

(1) Highlight the images you wish to print.
(2) Click on the Half Page button.
(3) Make sure that the “Maintain Aspect Ration” option has an “X” in the status bar to prevent

image distortion.
C. Print catalog with file name, original path, and “Notes.”

(1) If any images are highlighted, they will be included in the catalog.  If no images are high-
lighted, all of the images in the library will be included in the catalog.

(2) Select “Catalog” option.
(3) Select “Detailed” option.
(4) Make sure that the “Maintain Aspect Ration” option has an “X” in the status bar to prevent

image distortion.
D. Catalog of images with keyword only (i.e., the word or file name that appears below the image

in the thumbnail view window).
(1) If any images are highlighted, they will be included in the catalog.  If no images are high-

lighted, all of the images in the library will be included in the catalog.
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(2) Select “Catalog” option.
(3) Make sure that the “Detailed” option is not selected.
(4) Select the number of images to print on a page in the “per page” scroll selector.
(5) Make sure that the “Maintain Aspect Ration” option has an “X” in the status bar to prevent

image distortion.
5. If you wish to change the printer setup, you may select the “Setup” button in the upper right corner of

the Print Layout dialog box.
6. Click on the Print button to begin the printing process.
7. Click on the Cancel button to exit the Print Layout dialog box.

MasterClips MediaPaq Browser  features a number of print options with which you may print images in a
media library.

To print one or more files in MasterClips MediaPaq Browser:

1. If you do not have a media library open at this time, you should open it.
2. Hold down the Ctrl key while successively clicking on five images in the library that you wish to

print.
3. Click on the Print button in the ToolBar.
4. In the Print Layout dialog box, select from these options:

A. “Full Page.”   Print image full-page (without file name or notes).
B. “Half  Page”  button.  Print image half-page with file name information and notes.
C. “Catalog” with “Detailed” option.   Print image catalog with “Notes” that may be attached to

the images or files.
D. “Catalog” (without “Detailed” option).   Print image catalog without file name information or

notes.
5. Click on the Print button to begin the printing process.
6. Click on the OK button in the Print dialog box to begin printing.
7. Click on the Cancel button to exit the Print Layout dialog box.

Record Sound
The Record Sound command permits you to record or import a sound and attach it to an image or to a

media library icon.  If your computer system has an optional sound card and microphone, you can create a
“talking” media libraries or library icons that verbally describes the content.

If you have an optional sound card in your computer, you may use the following procedure to attach or
import a sound and attach it to an image or file in a library:

1. Click once on an image in a library to highlight it.
2. Click on the image with the right mouse button to open the pull-menu.
3. Choose the Record command to open the Attached Sound Manager dialog box.
4. Click on the Record button in the Attached Sound Manager dialog box.  The progress indicator

displays the amount of hard disk space that you have remaining as you record.
5. Click on the Import button in the Attached Sound Manager dialog box to import an existing sound
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file.  Use the “Drives” and “Directories” selectors to select the desired sound file.
6. When the desired sound file is highlighted, click on the OK button.

To add a sound file or clip to a media library icon:

1. Click once on the media library icon to highlight it.
2. Right-click the highlighted media library icon to open the media library menu.
3. Choose the Record command to open the “Attached Sound Manager” dialog box.
4. Click on the Record button in the “Attached Sound Manager” dialog box.  The progress indicator

displays the amount of hard disk space that you have remaining as you record.
5. Click on the “Import” button in the “Attached Sound Manager” dialog box to import an existing

sound file.  Use the “Drives” and “Directories” selectors to select the desired sound file.
6. When the desired sound file is highlighted, click on the “OK” button.

It is important to note that the above procedure for attaching or importing a sound for an image file works
the same for attaching or importing a sound for a media library icon in the SpeedBar.

Play Sound
The “Play Sound” option permits you to play a sound that is attached to an image or to play a stand-alone

sound file in a media library.

Tip: If you have a sound card installed in your computer, make sure that it is properly installed and functioning correctly prior to using MasterClips
MediaPaq Browser.  Contact the manufacturer of the sound card if you are unable to solve a sound problem.

If you have an optional sound card in your computer and you have a sound attached to an image, you may
use the following procedure to play the sound:

1. Click once on an image that has a sound attached to highlight it.
2. Click on the “Play” icon in the ToolBar to play the sound.

Changing Thumbnail Display Size
When you create a new media library, MasterClips MediaPaq Browser  defaults to the smallest size for the

display in the thumbnail view window (64 pixels x 48 pixels) or, for image on CD, the size in which the images
were generated.  Displaying the thumbnail images at the smallest size lets you view more images in the
MasterClips MediaPaq Browser  window at one time.  With certain file types, it is desirable to increase the
size of the thumbnail images so that you can see them more clearly.

You can increase or decrease the size of the thumbnail images in the thumbnail view window by clicking
on the “Zoom Out/In” button in the ToolBar or by pressing the + or - keys.  To reduce the size of the thumbnail
image in the media library, click on the minus (i.e., “-”) portion of the “Zoom Out/In” button.  To increase the
size of the thumbnail image in the media library, click on the plus (i.e., “+”) portion of the “Zoom Out/In”
button.  You may continue to click on the desired button until the thumbnail view reaches the smallest or
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largest display size (a beep will sound indicating that you have reached the minimum or maximum size for the
images).

If you wish, you may store images in the larger sizes.  You may turn on the “Retain most recent thumbnail
dimensions” parameter in the “Preferences” function in the “File” menu to store the library in the selected size.
Note:  You may not change the stored size of the images for libraries that are on CD or for libraries that are
read-only.

Regenerating Image Quality
When you resize images in a media library, you will notice that the quality of the image degrades with each

size change.  Changing from the smallest size to the largest size generally yields a thumbnail view image that
is illegible.  To restore the image quality, you must regenerate each image using the following procedure:

1. Click on an image with the left mouse button to highlight it.
2. Click on the image with the right mouse button to open the pull-down menu.
3. Click on the “Regenerate” option in the pull-down menu.

Repeat the above steps for each image that you wish to regenerate.

NOTE:  If you are using media libraries on a CD or that are read-only, MasterClips MediaPaq Browser  will not store the regenerated images in
the library.  When you open the library again, the images will revert to the default size and quality that was used to create the library on the CD.

Setting User Preferences
The “Preferences” option in the “File” menu permits you to set certain preference parameters in MasterClips

MediaPaq Browser .  These parameters include:
1. “Default Library directory .”  If you have MasterClips MediaPaq Browser  in one disk drive or directory

and would like to store all of your library files in another drive or directory, you may specify that location
in the “Preferences” dialog box.  All operations that use a disk drive location (i.e., “New,” “Open,” “Im-
port,” etc.) will default to the disk drive location specified in the “Default Library Location.”

2. “Retain most recent thumbnail dimensions.”  MasterClips MediaPaq Browser  has the ability to dis-
play images in a wide range of sizes from 64 x 48 pixels to 256 x 256 pixels.  If this option is not checked,
MasterClips MediaPaq Browser  will store the library images in their smallest size.  If you change the size
of the images in the thumbnail view window during a session, the images will revert to the smallest size the
next time you open the library (unless the media library is stored on a CD or is a read-only file).  If you turn
this feature on, MasterClips MediaPaq Browser  will store the library in the size of the image that you
currently have selected in the thumbnail view window (unless the media library is stored on a CD or is a
read-only file).  Storing images in a larger size does require more disk storage space for the media library.

3. “Store regenerated thumbnail image.”  When you import an image into a library, MasterClips MediaPaq
Browser  gathers enough information about the image to reproduce the image in the thumbnail view win-
dow.  If you change the size of the image in the thumbnail view window after you import an image, you
will notice that the quality of the thumbnail view images deteriorate.  To restore the quality of the image
display, you must regenerate the image using the “Regenerate” function.  Regenerating the images in a
library may consume twice as much disk space if the images are large.  You should carefully consider the
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amount of disk space required for large images before you choose to save them in the regenerated state.
On the other hand, regenerating image quality is time-consuming for large files.  Saving the files in their
regenerated state can save a great deal of time in working with the library.  Select “Store regenerated
thumbnail image” to store the images at their regenerated quality.

4. “Always display images full screen.”  This option forces MasterClips MediaPaq Browser  to always
display the “Show” window images at their largest possible size for the current screen resolution.

5. “Automatically play attached sound when viewing.”  If this option is selected, any sound that may be
attached to an image is played when you view the image (i.e., double-click on the image or select the
“Show” window button).

6. “Stay on top when minimized.”  If this option is selected, the MasterClips MediaPaq Browser  icon will
remain on top (i.e., visible) in the lower-left corner of your screen regardless of which application is active.

Exiting MasterClips MediaPaq Browser
The “Exit” option in the “File” menu closes any media libraries that may be open and exits MasterClips

MediaPaq Browser .  If any media libraries have images or files that have been marked for deletion, MasterClips
MediaPaq Browser  will physically remove them from the media library before closing.

Summary
This completes the tutorial on the basic features of MasterClips MediaPaq Browser .  While this chapter

does not cover all of the many useful features built into the program, it does give you an overview and opera-
tional knowledge of the most commonly used functions and operations to help you make efficient use of the
program.
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